First Time Use

This tutorial’s purpose is to introduce you to the SCOPE SDK software.  It will cover the basics of using the software in addition to providing you with the fundamentals of assembling a device.

To start, run the SDK by double-clicking (or single-clicking, depending on your Windows customization) the Scope SDK icon on your Windows desktop.  Please note that all other Scope applications must be closed before running the software!

The SCOPE SDK will now appear.  It will look similar to the picture displayed here.
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You will see several windows: the main SCOPE SDK window, which currently houses the Project Window, the File Browser, and the Toolbar. Other windows will be opened and used later.
The Toolbar gives you quick access to many of the components of the SDK.  Most of the items on the Toolbar are graphics options for designing device surfaces which we will discuss later in this tutorial.

The File Browser allows you to navigate your hard drive and load modules and other items into the SDK through a drag-and-drop method.  (For more information on the File Browser, see Software Interface Guide.)
The Project Window is where you will be doing most of your work.  As you can see, it is blank except for a number of blue-colored boxes called modules.  Modules are very important and will comprise the underlying infrastructure of your device.  There are hundreds of modules available that can be loaded into the Project Window. Modules can perform a vast number of functions, and they can be connected together in various ways via pads and virtual “cables.”  The Circuit Design Tutorial Part 1 contains more details on how modules work and interact with each other.  Devices will be made up of multiple modules.
A project saves the current configuration of the modules and devices, including how they are arranged on the screen.  Projects also contain certain settings related to the SDK program itself.  It must be noted that a project can save modules inside of itself, whereas it must reference devices directly off the hard drive.  In the case that devices get moved to another directory, the SDK can search for them and load them automatically.  Later in this tutorial you will be building a device inside of a project.
As you can see in the default project, there are several modules loaded.  The default modules represent your SCOPE software and hardware I/Os, building the basis of your project.  If you have multiple hardware boards, the project will display the basic I/Os of the first board.  It is likely you will want to customize this default project to your liking.
Initial Setup

Before you begin your work, you will probably want to customize the SDK to appear exactly how you want it to look.  Some changes will be global: i.e., the software will look and act a certain way no matter which projects are loaded.  Other changes will be project-based.

At the top left of the main SDK window, you will see several menus: File, View, Window, and Devices.  The File menu is for loading and saving projects.  Once you have customized the Project Window to create a default hardware/software I/O configuration (one that you will want to load automatically every time you load the software), you will want to save your project via the File menu.  The File menu contains the following items: New, Open, Save, Save As…, Open Recent (via a sub-menu), and Exit Scope.
The View menu is where you will customize global and project-based settings. The menu contains the following items: SampleRate, Settings, DSP Load, Registry, MIDI Controller, Control Ranger, and About.

SampleRate

SampleRate changes a number of hardware settings.  The SCOPE hardware is always operating at a certain rate (number of samples per second), which can be one of four rates: 32KHz, 44.1KHz, 48KHz, and 96KHz. For best compatibility with other hardware and software, leave at 44.1KHz.  Changing the sample rate affects the sound quality of your devices (higher sample rate = higher quality), so you may want to change this setting sometimes to see what effect it has.
Most of the time you will want to have your SCOPE board(s) generate the sample rate (clock) signal.  If, however, you have your SCOPE boards connected to other external hardware, you might want SCOPE to sync with the other hardware’s clock signal.  To do this, determine which SCOPE input the other hardware is connected to (must be a digital connection, not analog), then select that input in the list.  Click on the “Slave” button.  It is advisable to have the speaker volume turned down in case of transients!  In a moment SCOPE will readjust itself to the other hardware’s clock signal.  To return to a SCOPE master signal, click on the “Master” button.  If the “Slave” button is activated but no other hardware is present, SCOPE will not operate at all until a signal is detected.
Typical digital inputs will be S/PDIF (Coaxial), ADAT A/B, S/MUX, and S/PDIF Optical.  The various inputs on your unique hardware boards will all be displayed at once, allowing you to select one input for clock detection.  There is an additional setting as well: allowing you to select between S/PDIF Optical and ADAT, as these two protocols go over the same I/Os.  This option acts slightly differently depending on which I/O daughterboard you have on your hardware (Scope Project and Scope Professional only).

If you have a Classic or Plus board, and the ADAT option is selected, an S/PDIF signal is permitted using the S/PDIF modules, as well as a 16-channel ADAT signal via the ADAT I/Os.  If the S/PDIF optical option is selected, the ADAT A port switches to 2-channel S/PDIF optical.  Output is transmitted via both the optical and coaxial S/PDIF ports, and coaxial S/PDIF input is disabled.  Use the normal S/PDIF modules to access the S/PDIF optical I/Os.  ADAT B continues functioning in 8-channel ADAT mode.
If you have a Z-Link board, there is only one ADAT I/O.  In this case, the S/PDIF coaxial is unaffected by either setting.  If the ADAT option is selected, the ADAT port functions in 8-channel ADAT mode.  If the S/PDIF optical option is selected, the ADAT port switches to 2-channel S/PDIF optical.  Use this protocol via the special S/PDIF optical modules.  
The SampleRate settings are project-based.

Settings

This box is divided into several pages.  By click on one of the page buttons, you can switch to that page.  The pages are: Global, Config, ULLI, and Directories.

Global:

Enable Control Shortcuts: Don’t know what that does
Pot Movement: When making a device surface it is likely you will use rotary knobs and linear sliders, called potentiometers, to control parameters.  There are three methods of adjusting the potentiometers (pot for short).  Round 1 uses a “brute-force” method: when you click on the potentiometer, the pot will automatically “jump” to the place where your cursor is located, creating a large shift in the sound.  In some cases this may be rather dangerous, and it is not advisable to use this method.  Round 2 is the same as Round 1 except it does not “jump,” and it only moves when your cursor moves in a relative fashion.  In both Round movements you must move the cursor (holding down the mouse button) around the pot to adjust it (linearly for sliders), and the further the cursor moves away from the pot, the finer the range of control becomes.
Vertical is an easy method: both knobs and sliders get moved linearly—up and down for vertical sliders and knobs, left and right for horizontal sliders.  The range of control does not change when the cursor moves away from knobs, but it does change when moved away from sliders.

Screen Mode:  In earlier versions of SCOPE all components and windows were contained within one giant window (or desktop) which was usually confined to one monitor (dual-monitor setup was difficult and cumbersome).  This is now known as “Classic” mode.  In version 4.0, every window and dialog box displayed is independent of the main SCOPE desktop, which allows for easy movement to a second screen.  It is advisable to ensure this setting is in the new “Standard” mode.
Standard Cursor: SCOPE has its own unique set of mouse cursors that assist in assembling devices.  It is possible to use the standard Windows cursors instead by selecting this option, but it is best left deselected.

Enable Tooltips: When hovering the cursor over certain items, a Windows-style tooltip will appear with an explanation of the function of that item.  Usually this setting should be selected unless the tooltips become cumbersome in some way.

Save Recovery Files:  Don’t know what that does.

Config:

Don’t know what any of that does.

ULLI:

The adjusts the latency of the Windows wave and Steinberg ASIO audio drivers.  As the computer has to process audio in certain segments (buffers), not in a continuous stream, there will be a slight delay (latency) moving the audio from the host computer to SCOPE.  A lower buffer, or latency, will result in greater performance, but increased CPU usage; a higher latency will increase the delay, but utilizes fewer CPU cycles.  Slower computers will have to leave the latency high, whereas faster computers can decrease the latency.  This setting does not affect the internal processing of SCOPE, only the wave and ASIO drivers.
Directories:  Not sure what this does either.
All options in Settings are global.

DSP Load

The SCOPE boards can only process so much information at one time.  The more DSPs you have on your hardware, the more devices you can load.  The DSP Load box can tell you how much power you are using on your DSP boards.  It also tells you how many boards you have (up to 3) and how DSP chips are on each board.

You will also see two columns: Sync and ASync.  These terms must be familiar to you when you build a device.  See SCOPE Concept Guide for more details.
Registry

Certain devices from CreamWare and third parties are copy-protected: they contain a key that is tied to one of your DSP boards.  This dialog box tells you how many devices are registered with your unique boards, as well as the serial numbers for your boards and the key numbers for your devices.  These numbers have very likely been imported from the Scope Platform 4.0 software or from CreamWare’s Online Shop.

MIDI Controller
If you are working on a device with MIDI capability, and you have a surface with potentiometers, you can assign a MIDI controller number to the pot by clicking on the pot, waiting for a MIDI controller signal, and clicking the + button when one appears in the “New” section.  To remove the controller number, click the – button.

Control Ranger
This is a part of MIDI Controller, but at this time it is not functional.

About
This brings up the programming credits for the SCOPE SDK.

Congratulations!  You have now set up all “under-the-hood” settings.  Next we will adjust the display of the SDK windows to fit your needs, and then we can begin building a device!

The next menu on the menu bar is Window.  These items can open windows and components of the SDK which will assist you in building a device.  The items on the Window menu are: Toolbar, ProjectExplorer, Project Window, File Browser, DSPModuleList, Parameter: Parameters and PresetParameters, GOTree, Alignment, Blit, Color, Dimensions, Gradient, Preview, Shadow, Text, and Texture.
You should see checkmarks next to Toolbar, Project Window, and File Browser; that’s because they’re currently open.  Click on ProjectExplorer.

The Project Explorer is a companion to the Project Window.  It shows you everything that is loaded in your project as well as its subsequent devices and modules.  It is organized in a tree structure, with parent and child modules.  We will discuss the uses of the Project Explorer below.

The four windows you now have open you will need to access frequently, so it is best to leave them open permanently.  Two other windows should also be open permanently:

In the Project Explorer, click on Pad I.  This brings up PadList I.  You will see an option to open Connections; open that as well.

The Project Explorer, the PadList I, and Connections will all be used together, so they should be located very near each other on your screen.  Note how the SDK is arranged in the following example.

We are now ready to build a device!  It is advisable to read the SCOPE Concept Guide and Software Interface Guide before continuing, so that you can get an idea of the underlying structure of device creation and functions.  If, however, you are too anxious to wait any longer, you can just try experimenting along with this tutorial.

Building a Device
Our first device we will build will be a simple lowpass filter controlled by an LFO (Low Frequency Oscillator), complete with volume and pan modulation.  To start, navigate the File Browser (for more information on the File Browser, see Software Interface Guide) to Scope SDK ( Circuit Design ( Basics.  Click on Empty Insert FX and drag it into the Project Window.
You will see a new module in the Project Window as well as a module surface.  Close the surface for now.  (To open a module’s surface again, right-click on the module and navigate to Surfaces ( Open Panel.)  Connect the input pads of the module to the desired audio source by clicking on the pad InL and immediately afterwards clicking on the pad LOut of Wave Source 1 (or whatever audio input you wish to use).  Then press the letter n on your keyboard to hook up the right channel.  Then connect the pad OutL of Empty Insert FX to the pad LIn of your board’s Analog Dest (or whatever output you desire).  Double-click on the module.

You are now looking “inside” of the module.  Further modules can be dragged into this space, which in turn can viewed inside.  These modules are known as child modules inside of a parent module.  You will notice that the Empty Insert FX is now displayed inside the Project Explorer.  You will also see that all the modules contained inside of Empty Insert FX are displayed in both the Project Window and the Project Explorer.  It must be noted that while the Project Window can only view the insides, or level, of one module at a time, the Project Explorer can “see” everything at once.

The uses for most of the modules contained in Empty Insert FX do not need to be explained right now.  You will see two modules with labels next to them: Effect Input and Effect Output.  You need only pay attention to those modules for now.

Creating Circuits
Main Effect Circuit
In the File Browser, navigate to Circuit Design ( Filters ( Sound Design.  Drag the LP 24db Vintage module into the Project Window TWICE, one below the other.  Connect the pad labeled in on the first filter to the pad labeled outL of Effect Input, and connect the right output of Effect Input to the in of the second filter.  Then connect the pad labeled out on the first filter to the pad labeled inL on Effect Output, and connect the right input of Effect Output to the out of the second filter.
You have now created a circuit!  (See SCOPE Concept Guide 1.)  When you run audio through your new device, you will hear the effect of the lowpass filters.  However, at the moment you can only control the filter of the left or right channel at one time.  To control them both at the same time, further modules must be inserted.

Double-click on one of the filter modules.  This will take you inside the filter module.  Right-click on the two modules you see, SurfaceInterface and Panel, and delete them by selecting Remove Module.  Return to the previous level by double-clicking on a blank space of the Project Window.  Do this same step for the other filter.

Now drag in a surface control by navigating the File Browser to Surface Design ( Controls ( Potentiometers.  Drag Pot Dark into the Project Window.

You will see a pad labeled Val next to the knob.  Connect it to the inputs labeled f on the two filter modules.  These cables are colored green because they are an ASync connection (see SCOPE Concept Guide).
For the moment you are done with the circuit.  You can arrange the position of the modules on the screen by clicking and dragging them; good organization and low clutter is the key to building an efficient and effective device.

You can now control the lowpass filters’ filter control by clicking on the Use button in the top left corner of the Project Window.  This allows you to manipulate the knob’s output value instead of changing its position on the screen.  By adjusting the knob you should be able to hear it filter out the high frequencies of the audio as you turn it to the left.

The response curve of the knob may seem strange as you adjust it: there will be a huge sweep in the audio during the low values of the knob’s output, and at about ten o’clock the sweep will have nearly reached the top.  We will now change the pot’s internal response to fix this.

As was mentioned before in the window arranging section, the windows Project Explorer, PadList I, and Connections should all be open.  The Project Explorer can open PadList I by clicking on the Pad I button, and PadList I can open Connections by clicking on the Connections button.  Arrange these windows near each other on your screen.

Having clicked on the pot, go to PadList I and click on the button labeled Vars.  This will show you the available internal settings for the pot.  You will see that Curve has a value of 0, and Intensity has a value of 10.  Change the value of Curve to 1 and the value of Intensity to 100.  Now the curve response of the knob should be satisfactory.

If you adjust the knob quickly, you may hear a “zipping” noise.  This is because the resolution of the knob is coarser than the resolution of the filters.  An interpolate module must therefore be inserted between the pot and the filters.

Disconnect the cables between the pot and the filters by clicking on the individual cables and pressing the Delete button on your keyboard.

Click on the Window menu and select DSPModuleList.  This brings up a list of the DSP modules available.  These modules are different than the modules you have been dragging in previously: they are the lowest-level modules available, also known as atoms, containing only executable code and no further modules inside.  They have no surfaces for this reason.
Scroll down until you see the module Interpolate.  Drag this into the Project Window.  Connect the Val output of the knob to the In of Interpolate, and connect the Out of Interpolate to the f inputs on the filters.  You can adjust the position of the modules by clicking on the Move button next to Use on the top left corner of the Project Window.  In Move mode you can adjust the position of modules on the screen as well as enter into a module’s level.  Switch back to Use mode to adjust the knob’s output value.
The filter sweep of the knob should be much smoother now.  It is very fun to play with this sort of thing!

As you can see, there is also a resonance control on the filters.  This boosts the signal right at the point of the filter cutoff.  You can control the resonance in a similar manner to the filter cutoff: switch back to Move mode, drag in another Pot Dark, and connect the output to the Res. inputs on the filters.  You probably won’t need to insert an interpolate modules to control the resonance.  Be careful that you don’t turn the resonance too high!

Modulation Circuit
So far, you have only been able to control the filter with mouse-based controls.  How about some internal controls, such as an LFO (Low-Frequency Oscillator)?

To begin this next phase, disconnect the cables between the Interpolate module and the filters.

Bringing up the DSP Module List again, find Pitch Modulator 2 R5 and drag this into the Project Window.  This will allow an LFO to modulate the signal output from the pot.  Connect the output of Interpolate to the green f input on Pitch Modulator, and connect the red f output to the F inputs on the filters.

Next, in the File Browser navigate to Circuit Design ( Oscillators ( LFOs and load Tiny Sine LFO.  Keep the LFO’s surface interface open where you can get to it easily.

Connect the output of the LFO to m1 on Pitch Modulator.  The frequency of the LFO is currently set to 40hz; change that to 1hz.  You can adjust the gain (volume) of the LFO as well as the hard output of the filter pot to get a wide range of modulation coverage.

Mixer Circuit
Now let’s add some volume and pan modulation—basic mixing tools.

Switch to Move mode and disconnect the outputs of the filters from the Effect Output module.

Navigate to Circuit Design ( Signal Adders ( Mix and drag in Mix 1 twice, one below the other.  Position them between the filters and Effect Output.  Connect the output of the first filter to the input of the first Mix 1 and connect the output of the second filter to the input of the second Mix 1.  Close both surfaces of the two Mix 1s for now.
Navigate to Circuit Design ( Mixer Components, and drag in Script Pan.  Connect the output of the first Mix 1 to the left input of Script Pan, and connect the output of the second Mix 1 to the right input of Script Pan.  Then connect the left output of Script Pan to the left input of Effect Output, and then press the n key on your keyboard.
Change the left and right panning of the signal by adjusting the pan knob or entering in an amount in the Script Pan surface.  Double-click the knob to return to Center and close the interface.
You now have a pretty complete signal path for this type of effect.  You have a stereo lowpass filter with LFO modulation, along with volume and pan modulation.  Of course there are loads of other goodies you can add to this effect, but for now we’ll keep it fairly simple.

Circuit Organization
The circuit is beginning to look a little cluttered.  For such a simple device there seems to be a lot of modules!  How can you clean this up?  You can clean it up by folding modules.
Folding modules means taking two or more modules and combining them into one module.  For example, we can take the two lowpass filters and fold them into one module while preserving the I/O connections.  When you double-click on the folded module, you will be able to look inside the module and see the two filters you folded together.

Click on a blank space in the Project Window to deselect all modules.  Then select the two filters by shift-clicking them (clicking on the modules while holding down the shift button on your keyboard).  Fold them together by pressing <Ctrl>-<F> on your keyboard.

The two filters will disappear, and you will see a new module titled: Folded_LP 24db Vintage.  The pads are still connected, and when you double-click on the module, you will see the two filters, which are now child modules of the folded module.
What are those little arrows you see around the pads of the filters?  Those signify that the pads are exported.  Exporting means sending a module’s pad to the parent module.  As you can see, every pad on these filters is exported.  When you double-click on the Project Window to bring you up to the previous level, you will see that all those pads are likewise on the parent module, Folded_LP 24db Vintage.  Any pad on any module you see can be exported, and we will manually export our own pads later in this tutorial.  Look at those Switch modules at the top of the Project Window; you can see some pads are exported.  Those are the audio I/Os that you connected when you first loaded up Empty Insert FX.
Let’s fold some other modules now.
The two knobs plus the modules Tiny Sine LFO, Pitch Modulator, and Interpolate all serve one purpose: to modulate the filters.  We’ll fold those five modules together.

Again, click on a blank space in the Project Window to deselect all modules.  Then shift-click the five desired modules (be careful when clicking on the two pots: don’t click on the connection pad) and press <Ctrl>-<F>.

It doesn’t appear that these modules folded together correctly.  The output of Interpolate is connected to Pitch Modulator outside the new folded module.  This is because of the Sync/ASync connection.  This can, however, be fixed.  Double-click on the new folded module to bring you inside of it.  You will see arrows on Interpolate Out and Pitch Modulator f signifying that they are exported.  How shall we fix this?  Unexport the pads.

Right-click on the pad Out on Interpolate and select Delete Exported Pad.  Do the same procedure on the f pad of Pitch Modulator.  Now connect the two pads together.

Return to the previous level, which is the main view of Empty Insert FX.

We can fold the Mix modules and Script Pan together to form a Mix section.  Select the two Mix modules and Script Pan and press <Ctrl>-<F>.

This is a much cleaner setup now, isn’t it?  If you had many more circuits in this effect, you could fold together the three folded modules to clean it up even further.  However, the way it is now is sufficient for this effect.

Naming Modules
We have a couple more tasks to perform before we begin creating a device surface.

Now that the circuits have been completed, it’s a good idea to save your new device.  Double-click on the Project Window to move up one level.  Right-click on Empty Insert FX and select Save as new Module.  At the moment it only allows you to save the device with an extension of .mdl, which should only be used for individual modules, not a full device.  In the drop-down list labeled Save as Type:, select All Files.  Navigate the save dialog box to the directory of your choice, and save the device as: Tutorial Device 1.dev .
Once it has been saved, double-click on the device again.
The module names Folded_This and Folded_That are not very pleasing.  Also, some of those modules you have been working with, such as Interpolate and ASync Add, would quickly get lost if you had a lot of modules of the same type in the circuit.  How would you differentiate between them?  You can rename the modules!

Every module can be renamed to your choice.  This is done in the Project Explorer.

Click on Folded_LP 24db Vintage.  You will notice that that module has been selected in the Project Explorer—its name has changed color to a light blue.  Click on the name, and a couple of seconds later click on it again.  This will allow you to type in a new name.  Call it Filter Section.

The name will now change in both the Project Explorer and the Project Window.  If the cables display out of alignment with the pads, just move the module a bit.

Select Folded_Mix1 (or Folded_Script Pan) and rename it in the Project Explorer to Mix Section.  You can also select modules directly in the Project Explorer as well; do this for Folded_Interpolate (or whatever the modulation section happens to be named).  Rename it to Modulation Section.

Some of the child modules should be renamed as well.  Double-click on Filter Section.  Select the first filter and rename it to Left Filter.  Select the other filter and call it Right Filter.  Return to the previous level in the Project Window.
You can see in the Project Explorer that the names of the two filters are offset to the right from Filter Section.  This shows that they are children of Filter Section.
Double-click on Mix Section and rename the first Mix 1 to Left Volume.  Rename the other Mix 1 to Right Volume.  You don’t need to rename Script Pan unless you choose to do so.  Return to the previous level.
As you can see on Filter Section, there are two pads labeled Res. and two pads labeled f.  Which pads are which?  Which modules are they connected to?  You must rename the pads to remind yourself this in the future.
Click on Filter Section.

In Pad List I, you will see a list of eight pads.  Two pads labeled in, two pads labeled out, two pads labeled Res., and two pads labeled f.  Click on one of the Res. pads.
In the Connections box, you will see two items: Pot dark Val and either Left Filter Res. or Right Filter Res.  Click on the Res. pad again, and a couple of seconds later click on it yet another time.  Rename the pad to either LRes or RRes, depending on whether the pad is connected to the right or left filter.  You can have a maximum of four characters in a pad label.

Change the f pads in a similar manner, by checking its connection in Connections, to LFrq and RFrq.  Change the In pads to LIn and RIn, and change the Out pads to LOut and ROut.
You should rename the pads of Mix Section as well.  Click on the Mix Section module and rename the two In pads to LIn and RIn, checking the Connections box to confirm which pad you’ve selected.

As one last step, rename Empty Insert FX in the Project Explorer to Tutorial Device 1 or LFO Filter.  This will rename the device.  You will see the new name in the top level of the Project Window.  Save the device once more, overwriting the file you saved previously.  You will need to switch to Save as Type: All Files again to see the device with the extension .dev.
We’re now done with the circuits!  Congratulations!  There may be a couple of extra things to do in Circuit View while we’re making the device surface interface, but for now we’ve completed the circuit design.  Everything is ready for building the surface.
Building a Surface
To start building the surface, click on the button labeled Surface at the top right corner of the Project Window.  Make sure you are first looking at the level of Empty Insert FX in Circuit View, otherwise you will not see anything.  If you need to return to Circuit View, click the Circuit button next to Surface.
In Surface View, you will now see a little surface box labeled Empty Insert FX.  The box is rather small, but it is big enough for the moment.

Onscreen Controls and Connections
You can begin dragging objects onto the interface.  Navigate the File Browser to Surface Design ( Controls ( Potentiometers and drag in Pot Dark.  Place it on the interface, not on the blank Project Window.  You must be in Move mode for this to work!
Drag another Pot Dark onto the interface, placing it just to the right of the first one.  We’ll make the one on the left the filter control, and the one on the right the resonance control.
Click on the first knob.  You’ll see its name highlighted in the Project Explorer: Pot Dark.  Rename the first knob to Filter Knob, and rename the second knob to Resonance Knob.

So far, you have been connecting all modules together via cables.  How shall you connect these knobs to the circuits?  By using the following method.

Return to Circuit View and go into Modulation Section.  See the two potentiometers you have been using previously?  While you could connect the surface knobs to any pad available, for now we will be connecting them to these knobs here, for ease of use.
Return to the previous level, switch to Surface View again, and click on the first knob.  In Pad List I, you’ll see a pad labeled Val.  Click on the name of the pad once, and then click the Store button directly above it.  This “stores” the pad in memory so you can connect it to something else later.  Remember: you can only keep one pad in memory at a time!
Return to Circuit View.  Double-click on Modulation Section and click on the knob connected to Interpolate.  Then click on the Val pad in Pad List I and select the Connect button directly above it, right next to the Store button.  You’ll now see that a new connection has been made in the Connections box: Filter Knob Val.  While you’re here, you may as well rename the two circuit knobs.  Change the knob you have selected to Filter Knob Circuit, and change the other knob to Resonance Knob Circuit.
Doucle-click to move up a level, change back to Surface View, and switch to Use mode.  The left knob on the panel can now change the filter response!  Of course, the new knob is in its default response curve, which means you must change it to match the circuit knob.  In Pad List I, switch to Vars view, and change Curve to 1 and Intensity to 100.  Switch back to Pad view and manipulate the filter knob again.

Now let’s connect the second knob.  Click on the second knob and store its Val.  In the Project Explorer, locate Modulation Section ( Resonance Knob Circuit and click on the name.  Click on Val and Connect.
Labeling Objects
We should label these two knobs on the device surface so that we know what they are!  Change to Move mode and move the two knobs towards the top left of the blank frame in the device surface, leaving a little room at the top and left.  Navigate the File Browser to: Surface Design ( Text, and drag NewText into the panel.  Move the new text to just above the filter knob.  Drag in another NewText and place above the resonance knob.  Move the items to the desired locations.  As you move the items, you will have a rather coarse placement grid, and something may not be able to line up.  To move objects one pixel at a time, you can either use the arrow keys on your keyboard or hold down Shift as you move the item.  (Shift also selects and moves multiple objects, so use the Shift method with caution.)
We’ll want to change the text to say something else, as well as change the font and color.  Select the NewText above the filter knob.

It is now highlighted in the Project Explorer.  Rename it to Filter Text.

To change what the text says on the surface, you’ll see a pad in the Pad List labeled: Str (for String).  Change the value of the String to Filter.

It just changed the text on the surface, now longer lined up with the knob.  Move the text to the desired location.

Use this same procedure with the resonance text: click on the text, rename it to Res. Text, and change the String to Res.  With shorter labels now, you can move the knobs closer together.
Color & Font
Let’s change the color and font of the text.

Click on the Filter text and open up the Color Selector by clicking the Color button on the Toolbar.  (Will have picture in the final manual.)  This brings up the Color Selector.
It is desirable to ensure that your monitor is set to 32-bit True Color, as this will allow you to see the full range of available colors.  You see there is an outer ring of colors as well as an inner box.  The outer ring allows you to select the color’s hue, and the inner box allows you to select the color’s brightness.  In addition, you can also enter in manually the desired color through the red, green, and blue control fields.
To change the color, click anywhere in the hue ring or the brightness box.  The color point will automatically jump to the place you have selected.  For fun, you can drag the points around in the ring and the box and see the color change in real-time.
It is not likely you will find a permanent color for the text, as you will be changing the color of the main surface frame later.  So, for now, leave it at black (any hue).

Close the Color Selector and open the Font Editor, the “A” button just next to the Color Selector button.  Here you will see a great deal of options, some rather similar to word processors with which you may be familiar.

If you have tooltips enabled, hover the mouse cursor over each object in the Font Editor.  This will tell you what the various functions do.
There are two pages in the Font Editor: Main and Add.  Main gives you such options as Bold, Italics, Justification, etc., and Add gives you text scaling options.  Experiment with these options to arrive at the desired look.  You can change the font size by dragging up or down the font size number or by entering in a number with your keyboard.  Also, you can change the font face by clicking on the arrow next to the font name.  This displays a drop-down menu of the available fonts on your system.  Try to use standard cross-platform fonts (search for a list on Google).

When you have reached the desired font, close the Font Editor.

Click on the frame of the device surface and bring up the Color Selector again.  By changing the color you can change the main device color.  You can choose any color you wish, but keep in mind that certain colors are not pleasing to the eye!

Perhaps we should change the device’s name now.  Normally you would change text with the method we have used before, but the title of Empty Insert FX is set to be non-selectable.  You must select it by clicking on the module Text “Panel” located in Panel under Tutorial Device 1 in the Project Explorer.  Now bring up the Font Editor.  Change Empty Insert FX to Tutorial Device 1.

Now that you have selected a color for your device, you can click on the Fitler and Res. text to change the text colors to a desired color.
Control Fields
What if you change the filter lowpass position and then wish to change it back?  You have no way of knowing what the former position was other than guessing.  For this reason, we must add a control field.  This will show us the numeric value of the filter position.
Navigate the File Browser to Surface Design ( Controls ( ControlFields.  Drag the module Range Text to just below the filter knob.

Store the pad Val in the Pad List.  Then click on the filter knob, select Val, and Connect.  Switch to Use mode and try moving the knob.

You see a huge amount of numbers that don’t mean anything!  This is because the control field is displaying the full scale of values, from 0 to 2147483647.  There is a way to divide that number down to a reasonable scale.

Click on the control field—it doesn’t matter if it wants you to type in something.  The first three entries in the Pad List are: Val, Curve, and Intensity.  Below that are Min and Max.  Change Max to 127, giving you a total of 128 values.  This is the standard MIDI scale, and you will be using MIDI later.
If you adjust the filter knob, you will see there are still decimal points.  Click on the control field again and scroll down the Pad List until you find Format.  It will read %1.4f.  What does this mean?  It means the control field is displaying the value in a format as follows: integer.four decimal values.  If you change this to %1.0f, it will display only the integer values.

The scale doesn’t seem quite right!  When the knob is pointing straight up, the control field reads 12!  That is because the filter knob is using an exponential scale; remember we changed its scale to 1?  To compensate for this, we must change the scale of the control field in the opposite direction.
Click on the control field.  Change its Curve to 2, Intensity 105.  Now it should display correctly.

The control field itself looks a little big; it’s taking up far too much room.  We must resize it.
Having clicked on the control field, navigate to the Window menu and select GOTree (Graphical Object Tree).  This will show you a list of graphic objects in a surface module and will allow you to adjust parameters.
You will now see a new window with different options.  There are two parts to the GOTree: the tree structure, which allows you to select components of a graphic module, and the parameter selection area.  If you can’t see one or the other, move the divider line to the middle of the window.  (Will have picture in final manual.)

In the tree structure, you should see several items.  Click on Back1.

Now bring up the Dimensions adjuster from the Toolbar. (Will have picture.)  You will see four different parameters.  The top right one is the horizontal width.  Type in 30, and you will see the filter control field change size!  You can now move it to directly below the filter knob, fine-tuning if necessary.

One last step: select the control field and rename it in the Project Explorer to Filter Field.
You should now be able to know how to add a control field for the resonance.  Make sure you’re in Move mode, then drag in another instance of Range Text (placing it below Resonance Knob), connect it to Resonance Knob, change the max display value to 127, and change the format to %1.0f (you don’t need to change the curve).  Bring up the GOTree and Dimensions, change Back1 to 30, and rename the module in the Project Explorer to Resonance Field.
Adding Other Objects

Now we should add controls for the other components of the device before the surface design is complete.  We need the LFO frequency control, the LFO gain control, the volume control, and the panning control.  You will be using the same methods as before.

Drag in another Pot Dark onto the surface, placing it a little to the right of the resonance knob.  Rename the pot to LFO Freq Knob.  Drag in another instance of NewText, rename the module to LFO Freq Text, and change the String to LFO Freq.  For a control field, we can use the module Range Text Hz.  Drag it onto the surface and rename it in the Project Explorer to LFO Freq Field.
Click on the LFO Freq Knob and store its Val.  Navigate the Project Explorer to Tutorial Device 1 ( Modulation Section ( Tiny Sine LFO.  Click on the name of Tiny Sine LFO, and you should see a pad in the Pad List named F.  Click on the name of F and click on Connect.
Are we sure the range and curve response of the LFO Freq Knob matches that of the LFO itself?  We can check by bringing up the LFO’s surface.

Click on the LFO Freq Knob again so that its pads are displayed in the Pad List I and switch to Vars view.  In the Pad List I, there is a button labeled Freeze.  Click on that button: it “freezes” the pad list so that no matter what other object you select, the Pad List only displays the pads of the object that it showed when it was frozen.  How do you see other modules?  There is a second pad list.

In the Project Explorer, click on the little “+” icon next to Tiny Sine LFO.  This expands the listing of Tiny Sine LFO to show all child modules.  One of the child modules will be a module called Panel.  Right-click on the panel name and navigate to Panel Menu ( Show.  This will show the LFO’s surface.

Open the second pad list by clicking on the button Pad II in the Project Explorer.  This will bring up Pad List II which is identical to the first.  Normally it would show exactly what is displayed in Pad List I, but because Pad List I list is frozen, it will show another module.  Place it next to Pad List I.
Now manipulate the LFO frequency knob on the LFO’s surface.  As you can see, the value of the knob is updated on the Val pad on Pad List I.  When you look at the control field next to the knob, you’ll see it goes all the way to 150 Hz.  It probably shouldn’t go that far, because beyond 20 Hz, in combination with the lowpass filter, it won’t sound very good. So type 20 into the control field.  This changes Val in Pad List II to a value of 1789569.  Type that number in the Max field in Pad List I.
Other settings that seem different between the two knobs are Curve, which should be set to 1, and Intensity, which should be set to 7.56 (of course, you can change the intensity to anything you like).
Now, close Pad List II and deselect Freeze on Pad List I.  Connect LFO Freq Knob to LFO Freq Field.  The only setting of the field that needs to be changed is strMin: remove the inf. value.

Change the color and font of LFO Freq Text to match the other labels on the device surface.  The LFO Freq objects should be placed a bit apart from the filter objects to keep the sections separate.

Before we add any other objects, perhaps we should enlarge the device surface.  Click on a blank space on the device surface and open up the Dimensions dialog box (the one you opened to change the size of the control fields).  In the top right field, type in 450.  You will need to switch to Circuit View and back again to Surface View to update the screen properly.  Now you have more room to work with!

We’ll now add the controls for the LFO gain.  You should know the routine by now: drag in another Pot Dark and another NewText, but this time we’ll add Range Text 0db.  Rename the pot to LFO Gain Knob, the text to LFO Gain Text, the text string to LFO Gain, and the control field to LFO Gain Field.
Connect the field to the knob, and connect the knob to the Gain input of Tiny Sine LFO.
The response curve isn’t right, as you’ll see if you still have the surface of Tiny Sine LFO open.  Click on the gain knob on the surface of Tiny Sine LFO: its curve and intensity are 1 and 221.  Click on the LFO Gain Knob of Tutorial Device 1 and change its curve and intensity to match.

Now we will add the volume and pan controls for the surface, which are the last items.
Ensuring that you are in Move mode, drag yet another Pot Dark onto the device surface.  Name it Volume Knob.  Drag in another NewText, and rename the object to Volume Text and the string to Volume.  Change the text face and color to match the others.  Drag in another Range Text 0db and rename it to Volume Field.
As the volume mix is using the same db scale as the LFO Gain, the Volume Knob must also be set to a curve of 1 and an intensity of 221.  Then connect the Volume Field to the Volume Knob.  Store the Val of the Volume Knob.

Scroll the Project Explorer until you see Mix Section.  Expand it.  The child modules will be: Left Volume, Right Volume, and Script Pan.

Click on Left Volume.  In Pad List I there will be a pad labeled Gain.  Click on Gain and connect.  Do the same for the Gain of Right Volume.

The volume is now complete.  The last control is the L/R panning.  The panning control will be a little different than what we have been doing, as there will be several settings to adjust.

 As usual, drag in a Pot Dark and a NewText.  Name the knob to Panning Knob, the text to Panning Text, and the text string to Panning.  Change the text face and color to match the others.

Now drag in a standard Range Text.  Name it Panning Field and connect it to the panning knob.

Store the Val of Panning Knob and locate Script Pan in Mix Section.  There will be a pad called Pan: click on it and Connect.
Switch to Use mode and adjust the panning knob.  Of course the field is displaying nonsense numbers.  Click on the field and adjust the Format setting to %1.0f.

Now, as this is a left to right panning control, it makes the most sense to make the center display 0, the hard left display -64, and the hard right display 64.  Change the Max setting to 64 and the Min setting to -64.

But is that very obvious?  How would you know at first glance what those numbers mean?  There is an additional nifty tool that you can use.  Continue scrolling down the Pad List.  Just below Format are two settings labeled strMin and strMax.  These tell the field to show something when the minimum or maximum value is reached.  Type Left into the blank value of strMin and Right into the blank value of strMax.  One additional item: you’ll also see strMid.  Type Center into its value.  Now adjust the panning knob from left to right: you’ll see those items you typed in!
The surface is now complete!  You may need to adjust objects around to line everything up: remember to use the arrow keys to fine-tune!

MIDI
If you want to add MIDI control to adjust these knobs from a remote controller, do the following:

Return to Circuit View and double-click on a blank area in the Project Window to return to the top level.

Navigate the File Browser to Circuit Design ( Basics.  Drag Empty Synth into the Project Window; you will need to swipe a couple modules out of it.  Double-click on Empty Synth.

Two modules you need will be: MIDI Controller Linker and MIDI Channel Linker.  Right-click on one of them and select Save as New Module.  Save it in Circuit Design ( MIDI Components.  Do the same for the other module.
Now return to Tutorial Device 1.  Load the two modules from the File Browser and place them near each other.  Connect the pad Ch on MIDI Controller Linker to the pad CCon on MIDI Channel Linker.  Right-click on the green pad MIDI on MIDI Controller Linker and select Export Pad.

Move up one level in the Project Window.  You now have a new input on Tutorial Device 1: MIDI.  This input you can use to control the knobs on the device surface!

It is probably best to have the MIDI input pad on the left side of the module instead of the bottom.  To change it, select Tutorial Device 1.  In Pad List I, there will be a pad labeled MIDI.  Right-click on it and navigate to Orientation ( Left.

Parameters
There is one final task to do before the device will be ready: creating parameters.  (Also see SCOPE Concept Guide 2).  Parameters basically store settings that you specify that are read by the SCOPE software upon loading.  Parameters are most useful for creating presets (a file that contains a certain state of the parameters), but they can also serve other functions as well.

To begin, open the Parameters window located in the Window menu ( Parameter.  There will probably be no parameters listed at the moment.  If you are looking at the top level of the Project Window, click once on Tutorial Device 1.  You should now see four parameters listed.  Since every module can have its own parameters, and this view will change if you select anything else, click on the Freeze button on the Parameters title bar.  This will lock in the view of Tutorial Device 1.
As you use this device, you will want to save the current state of the knob controls on the device surface to make presets.  To do this, right-click on the Tutorial Device 1 module and navigate to Surfaces ( Open Panel.  Click once on the Filter Knob.  You will see the familiar Val pad in Pad List 1.  Select the name and drag it into the Parameters window, placing it on the gray area.

You will now see a new entry.  It will tell you the module name is Filter Knob and the name of the pad is Val.  You can rename that Val entry in the Parameters window without affecting its integrity.

Now, select every other knob on that surface and do the same thing, dragging the Val pad onto the gray area.  As you will see a lot of “Vals,” you can rename the name entries to match the module names.
These parameters will ensure that the adjustments you make will be stored when you save the project.  However, you can not yet make presets.

Close the device surface, but keep the Parameters window open.  Navigate to the Window menu ( Parameter ( PresetParameterList.  In this window you can create a preset list and drag parameters into the Preset Parameter List, which enables a preset to store those parameters in itself.  We do not yet have a preset list, though.

Click once on the Tutorial Device 1 module.  As on the other window, select the Freeze button on the Preset Parameter List.  Then press Create, which creates a preset list and adds new modules to your device automatically.

You can now drag every parameter ending in Knob from the Parameters window onto the gray area of the Preset Parameter List.  When you have finished, you will have six parameters listed.  If you did not rename those parameters, every parameter in the Preset Parameter List will read Val.
Now you can close the Preset Parameter List; every parameter you need for a preset has been added.  There are, however, other settings to add to the Parameters window that are not used in a preset.

In the Project Explorer, find MIDI Channel Linker and click on it.  You will see a pad labeled CSynth.  Drag this into the Parameter window and rename its name to cwMidiChannel.
Now, there should be two new modules located in Tutorial Device 1, but you will not see them until you close and reload the device.  Don’t forget to save first!
Once you have reloaded the device, you will see two new modules: PresetList and SurfaceInterface.  Select PresetList.

You will see many pads in the Pad List.  Scroll down to PresetFile1 and PresetFile2.  Drag both of those into the Parameters window (if it is not displaying the parameters of Tutorial Device, then unfreeze, click on the module, and freeze again).  Then scroll down to LastRestoredPreset.  Drag the pad into the Parameters window and rename it to cwLastRestoredPreset.

Conclusion

Congratulations: you have finished your device at last!  Save it one last time, and now it will be ready for use in the public SCOPE Platform software.  You have now completed the beginners’ course and are ready to move on to the intermediate tutorials of the software.
